Survey on Senior Secondary Subject Information 2024/25
Part II: WebSAMS Survey on Senior Secondary Subjects Taken by Students

Guidelines for Conducting the Survey in WebSAMS

Part I: Introduction

1. The “Survey on Senior Secondary Subject Information: 2024/25 School Year” (Part Il Survey),

short named as Survey below, aims at collecting information on the senior secondary (SS) subjects
taken by S4 and S5 students in the 2024/25 school year. Schools are required to report to the
Education Bureau (EDB) the SS subjects taken by students as at 10 October 2024 (Reference
Date).

The EDB will send a parameter file to school WebSAMS on 10 October 2024. The description
of the message (CDS) is “Survey on Senior Secondary Subject Information 2024/25 (Part II
Survey) — Parameter File”. School has to first import the parameter file in the “Data
Communication” of the Student module before the Survey can be conducted in the “Subject
Survey”, one of the sub-modules of the Student module.

Home

Student Info Enquiry

» School Management

Primary - AM Primary - PM Secondary - Whole Day
Profile 4 October » « 2024 p
Height & Weight Sun Mon Tue Wed Thu Fri Sat
Info Upload 1 Mational Day |2 & 4 b
Photo Upload

| 7 ] 9 10 11 H2
Sch House
Sectnaiblan 13 1 15 16 17 18 T
Subject Setup
Graduate Destination 120 21 122 23 24 25 26
Admission
IRTP 27 28 [29 30 131
Setup

1Customized day sequence is indicated in bracket ().
EosHnent IL - Long Week
Subject Survey
Report éo 10/10/2024: A CDS message with the Survey on Senior Secondary Subject Information {Part Il Survey)

parameter file received.

Data Communication

3. The Survey aims at collecting data of SS subjects (Annex) taken by each S4 and S5 student in the

2024/25 school year and supplementary information for the following subjects.

Subject Subject Remark
Code (supplementary information)
Chinese Language 080 - Offered for students taking HKDSE Examination
[Default value]

Offered for students not taking HKDSE Examination

Design and Applied Technology 3IN

Offered by own school or through Network
Music 218 Programme
Visual Arts 833 Offered by ATEC
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4. The subject data are extracted from the students’ subject set up in the Student module and the
class-based compulsory subjects set up in the School Management module (Only subjects with
EDB-defined subject codes will be captured). While preparing the survey return, please note

the following:

Please provide information on all SS core and elective subjects from the Key Learning
Areas, and Other Languages taken by each student (including subjects offered through
“Network Programme(s)” or by “Arts and Technology Education Centre (ATEC)”).

Please note that it is NOT necessary to add enrolment information on Applied Learning
courses for this Survey if the school has not assigned Applied Learning courses to students
in the Student module.

Please note that for the subjects Ethics and Religious Studies, Music, Visual Arts and
Physical Education, there is a code for the SS elective subject (i.e. an elective subject
that leads to the Hong Kong Diploma of Secondary Education (HKDSE)
Examination), and another code for the subject not leading to the HKDSE. Please use
the “HKDSE” subject code if the student studies the SS elective subject. The relevant
codes are listed as follows:

Code Subject
41N Ethics and Religious Studies (HKDSE)
21S Music (HKDSE)
83S Visual Arts (HKDSE)
41S Physical Education (HKDSE)

School should send the Survey return to the EDB through CDS

on or before 12 November 2024. Resubmission of data file is allowed before the deadline

Part I1:

Prerequisites

1. Please upgrade WebSAMS to Version 3.1.19 or above.

2. The EDB will send a message with a parameter file (STSURVEY.DAU) to school on
10 October 2024 for conducting the Survey. The file will be decrypted automatically in the CDS
module.  School has to import the file in the “Process Incoming Data” page in “Data
Communication” of the Student module before the Survey can be conducted.
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Part I1I: Procedure

1. Pre-task
0 Update Class and Subject Setup Information
e Update operating class information in the School Management module.

[5-SCHO09-01] School Management > Class Details= Setup

School Year

m  cesiow

secondary - Whole Day

O secondary 1 14 1E 1C 1D
| Gecondary 2 2h EZF 2C 2D
] secondary 3 M 3B 3T 3D
| Gecondary 4 44 4F 4T 4D
] secondary 5 s B ST 5D
| secondary B B4 BB AT AD

[ Add Mew Class ][ Delete Class Level ]

Update subject setup:

e You can add class-based compulsory or elective subjects in the Class Details of the School
Management module.

[S-SCH10-02] School Management = Class Details » Class-Based Subject Go to Class List

Basic Information | thgs-dug=: Suuj==:  Document

YYYY Secondary, Whole Day Secondary 4 - 4A

Add Class-Based Subject
Subject Detail Information

Subject |30 Chinese Language v |
_?:F?ie“ O] Compulsory
) Elective 2| v
Mol [thinese {Cantonese) ¥ | 3 v |
With Teaching Period Add more subject teacher..
Number of Period

Subject Component({s)

[ save || <]Back

e Schools may g0 to WebSAMS Central Document Repository
(http://cdr.websams.edb.gov.hk) and download the training material or application user
manual of the School Management module for information of adding subject groups and
cross-class subject groups.
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Q Update Student Profile and Subject Setup
e Update the profile of each student as at 10 October 2024, including name, STRN, class

assigned and departure record (if necessary). The STRN is the reference number of a
student provided by the EDB.

[5-5TU10-01] Student = Profile > Particulars 4Reg No 4 Cls No >
Address Schooling Guardian Sibling Special Ed Others Document Height & Weight
>Bottom
Reg No
fe Chinese Name
CC Code
Other Name Sex © Female @ Male
Date of Birth - - *Home District Council Central & Western
07/12/1997 (2 entra
(DDIMMAYYYY) ’
[S-STU20-02] Student > Profile > Schooling

Particulars Address | Zeiooling | Guardian  Sibling  Special Ed  Others Document Height & Weight

Edit schooling record

Reg No Name

School Year YYYY School Level secondary

School Session Whole Day Class Level secondary 4

Class Name 48 - Class No 7

SUDJECT Group First Day of Attendance in this Class ¢1/09/YYYY
(DDMMMAY YY)

Date of Admission Admission Type Others

rﬁ Save ] [ <JBack ]

Assign subjects to students:

e (lass-based compulsory subjects will be automatically assigned to students. You can

assign the subject group subjects or cross-class subjects to students in the Subject Setup
page of the Student module.

Schools may g0 to WebSAMS Central Document Repository
(http://cdr.websams.edb.gov.hk) and download the application user manual of the Student
module for information of Subject Setup.

[5-5TU44-01] Student > Subject Setup

School Year

School Level School Session Whale Day %
Class Level Secondary 4 % Class Name 40w
Setup @Subjeu:t Group, Elective Subject

'3::3'131':31.11:: for Cross-Class Subject (Mon-Subject Block)
) @roup for Cross-Class Subject (Subject Black)

% Search

QO Access Right Granting

e User(s) must have access right to access the Code Management, School Management,

Student and CDS modules.
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0 Incoming Message Handling
[Path: CDS > Incoming Message]

e Check whether the CDS Incoming Message “Survey on Senior Secondary Subject
Information 2024/25 (Part II Survey) — Parameter File” is received together with the
parameter file on 10 October 2024. The parameter file will be decrypted automatically in
the CDS module.

[5-CD&03-01] CDS > Incoming Message

HPage 1 = of11M ~Bottom

- Received
1] Subject (Code)| Type {Code}
Lesntel Loibite r - Time - Referen{: Deadlme Eﬁ[;e;::tt:e Indl{:ato @

50 | [ [Survey on Senior [ Subject ata (DAT)  10/10/2024 DD/MMYYYY | Mo ormal
Secondary Subject Burvey (3303 10:46 AM

Information 2024/25
(Part Il Survey) —

Parameter File ‘

2. Data File Preparation & Confirmation
A. Import the parameter file (STSURVEY.DAU)
[Path: Student > Data Communication > Process Incoming Data]
e Please select the message “Survey on Senior Secondary Subject Information 2024/25
(Part II Survey) — Parameter File” and click the <Import> button.

[5-5TU26-01] Student > Data Communication > Process Incoming Data
Frussgs fisopineg bEis . Prepare Dutgoing Data  Confirmed Dutgoing Data

. Subject Recenred EDB Reply Reply
sescrton

‘Survey on Senior Secondary Subject Information 2024/25 (Partll [ (1011012024
Survey) — Parameter File urﬂey 10:46 AM
(Data)
[ Browse [[ (3 1mport |

(2]

B. Maintain Survey Data
[Path: Student > Subject Survey > Prepare Survey on Senior Secondary Subject Information (Part II Survey) Data]

¢ You can use different criteria to search student(s), including class level, class name, subject,
MOI and remark in the interface of “Prepare Survey on Senior Secondary Subject
Information (Part II Survey) Data”.

(i) Assign subject remark

e Please choose the appropriate remark of the relevant subject from the drop-down menu
of the “Remark” column or use the <Assign> function to assign the subject remark to
selected students.
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[S-STUS55-01]Student = Subject Survey > Prepare Survey on Senior Secondary Subject Information (Part 1| Survey) Data
Prepare Survey on Senor Secondacy Subject information (Pact BT Survey) Bata WG b el a1

Survey on Senior Secondary Subject Information (Part Il Survey)
School Year YYYY

School Level Secondary School Session  Whole Day
Class Level A1l - Class Name
Subject [411 w |

Mol [Al1 ~]

Remark [a11  ~|

@ Search [_@ Add ][ “ Delete ] j Preview & Print ]

Assign to students

To zelected student(s) taking |080 Chinese Language » | , assign |Offered for students taking HEDEE Examination w | in “Remark”
columm .
M 4 Page[l ~|of11 Pk M #Bottom

Subject Offered
Not Through

B Class (IS Student ' Taken by Network

No  Name the Programme
Student n

11 ETUDENT 145 Binlogy Chinese T O O
b3 {Cantonese )
0 50 Chinese Chinese Dffered for students not taking HEDSE Examination w | (] O
| Language {Cantonese )
102 C & Boc Dev Chinese Pl O O
| {Cantonese )
165 Englizh Chinese NE w D |:|
| Language {Cantonese
O £15 Mus1ci{HEDRE ) Chinese [f------ w O ]
| {Cantonese ) | - ___C
25 Chinese
| MathiCompulsory ) | (Cantonese U o
E Save @ Reset ~Top

Save the data before going to the next/another page.

¢ You can also assign the subject remark to selected students in batches.

e For narrowing down the scope of assigning subject remark each time, it is
suggested to select the relevant subject before assigning the remark.

[S-STUS5-01]Student > Subject Survey > Prepare Survey on Senior Secondary Subject Information (Part Il Survey) Data
ErepareSuveyion Semortse condamysubjectintonna o P cE i e bt W T {1 sl i

Survey on Senior Secondary Subject Information (Part Il Survey)
School Year YYYY

School Level Secondary School Session Whole Day
Class Level A1l v Class Name
Subject 215 Music(HEIRE

Remark [a11 v

@ Searth [_ﬁ Add ][ /- Delete ] [_- Preview & Print ]

Assign to students

Ta SEIE@ taking | 218 Music(HEDIE) v |, assign | Dffered by ATEC “in “Remark™
colunm.

b 0
. 0 0L
5 ‘ i O Hema A i £ 0
0 a i Progra
1
45 1 Ftudent & 13 Chineze Offered by ATEC - O O
uzic(HEDRE ) (Cantonese )
] A8 4 Btudent B Chinese | ------ w O O
9 uzic(HEDRE ) (Cantonese )
] 48 7 Btudent © Chinese | ------ - O O
uzic(HEDRE ) (Cantonese )
4B | 9 Btoudent D Englizh | ------ [
U Eus ic{HEDEE ) U U
) 54 | 3 Btudent E Chinese Offered by ATEC b
9 ﬁusw(HKDSE) (Cantonese ) U U
" S| 7 Btudent F 18 Chinese Offered h ATEC w
9 u=1c(HEDSE ) (Cantonese ) U U
54| 8 Btudent G 18 Chinese | ----.- w
- uzic(HEDSE ) (Cantonese ) U U

© [Hee][(Freet]
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(ii) Subject not taken by the student in the 2024/25 school year
[Path: Student > Subject Survey > Prepare Survey on Senior Secondary Subject Information (Part II Survey) Data]

e [fastudent has actually not taken a subject captured from the School Management and
the Student modules, please check the relevant checkbox under “Subject Not Taken by
the Student”. The subject not taken by the student will not be included in the data
file.

Save the data before going to the next/another page.

[S5-STU55-01]Student > Subject Survey > Prepare Survey on Senior Secondary Subject Information (Part Il Survey) Data
PropareSubvey ion SomosSecondacyssubjectintornaton | Part i Susv oy Bt T G0 R R ]

Survey on Senior Secondary Subject Information {Part Il Survey)
School Year YYYY
School Level Secondary School Session Whole Tay

Class Level Class Name
Subject

Mol

Remark

T

column .

0 zelected student(s) taking |080 Chinese Language w | , azsign |0ffered for students taking HEDSE Examination | in “Remark™

Subject Dffered

Cls Student N
W Class g~ "y Taken by Nefwork
(n Kl the Programme
Student ]
48 | 11 ETUDENT D45 Biology Chinese M~
0N (Cantonese )
O P20 Chinese Chineze | Offered for students not taking HEDSE Examination v | O O
| Lanzuage {Cantonese )
092 © & Soc Dev Chinese bty O O
| {Cantonese )
165 Englizh Chinese A w (] O
| Language (Cantonese )
O 215 Muszic{HEDSE) Chinesze Offered by own school or through Network Programme s (] (]
| {Cantonese )
a8 Chinese M~ O O
ath{Compulzory) | (Cantonese)

[(Cseve) | Bpreset

(iii) Subject Offered Through Network Programme
[Path: Student > Subject Survey > Prepare Survey on Senior Secondary Subject Information (Part II Survey) Data]

¢ Please check the relevant checkbox under “Offered Through Network Programme” to
show that the subject taken by a student is offered through the Network Programme.
This information will be included in the data file.

Save the data before going to the next/another page.

[§-8§TUS5-01]Student > Subject Survey > Prepare Survey on Senior Secondary Subject Information {(Part Il Survey) Data
PrepareSutvey onSemossecondasy subjectintomnaton PSR Sasray i bt T G L B RS E

Survey on Senior Secondary Subject Information {Part Il Survey)
School Year YYYY
School Level Secondary School Session Whole Day

Class Level Class Name
Subject

MOl

Remark

@ Search ] [ @ Add ][ 7 Delete ] Preview & Print ]

T

column.

o selected student(s) taking [0B0 Chinese Language w | , assign |Offered for students taking HEDSE Examination w|in “Remark™

Subject Offered

Cls  Student Not Through
W Class 5 pien Taken by Network
o sz the Programme
Student n
48 | 11 ETUDENT (45 Biology Chinese A O O
u{e] (Cantonese )
0O Pa0 Chinese Chinese | Offered for students not taking HEDSE Examination v | O O
| Language (Cantonese )
092 C & Soc Dev Chinese hé w O O
| (Cantonese )
165 Englizh Chinese A O O
| Language (Cantonese )
0 [15 Music(HEDSE) Chinese Offered by own school or through Metwork Programme s
| (Cantonese )
SRS Chinese N4 w O O
athiCompulzory ) | {Cantonese )
T

[(Howe ] (Brecer
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(iv) Add subject

[Path: Student > Subject Survey > Prepare Survey on Senior Secondary Subject Information (Part IT Survey) Data >
Add]

¢ [fyou need to add subject(s) to a student solely for the Survey, please click the <Add>
button.

e Search for and select the student. Then choose the subject to be added to the student
and other related information, including MOI and subject remark (if applicable), from
the drop-down menu and whether the subject is offered through Network Programme.

Save the data before going to the next/another page.

[5-8TUS5-01]5tudent > Subject Survey > Prepare Survey on Senior Secondary Subject Information (Part Il Survey) Data
Emsniz sl sl e T e e e e s e s e e e e e s e s Outgoing Data File

Survey on Senior Secondary Subject Information {Part Il Survey)

School Year YYYY

School Level Secondary School Session  Whole Dayw
Class Level all v Class Name
Subject | 411 v |

Mol [ 411 |

Remark 11 w

§ Search add | 7 Delete Preview & Print ]

[5-5TUB5H-02]Student > Subject Survey = Prepare Survey on Senior Secondary Subject Information {Part Il Survey) Data
Eomrmlns A sde ) e e e e e e (R s e R e e e sk Ourtgoing Data File

Survey on Senior Secondary Subject Information {Part Il Survey) - Batch Add (Student Details)
School Year YYYY

School Level Secondary School Session __Whole Da
Class Level a1l v Class Name @ | [4¢ +| |

2] [y ey

O 40 1 CTUDENT AEW
] 40 2 CTUDENT ABX
40 3 CTUDENT ABY
9 O 40 4 CTUNENT ABZ
] 40 5 CTUDENT ACA
] 40 f CTUDENT ACE
] 40 7 CTUDENT ACC

Survey on Senior Se
Subject 045 Biology hod

MOI English vl 1O
Remark TS
Offered Through O

Metwork Programme

ondary Subject Information (Part Il Survey) - Batch Add (Subject Details)

6 @R.eset
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(v) Delete added subject
[Path: Student > Subject Survey > Prepare Survey on Senior Secondary Subject Information (Part IT Survey) Data >
Delete]

e [f you need to delete a subject previously added to a student, please click the
<Delete> button.

e Search for the student with the added subject record by class level, class name, subject,
MOI or remark. Then select the record to be deleted.

Save the data before going to the next/another page.

[5-5TUS5-01]5tudent > Subject Survey > Prepare Survey on Senior Secondary Subject Information {Part Il Survey) Data

2o e e e e e S e e e e s e e e (e R s R R Outgoing Data File

Survey on Senior Secondary Subject Information {Part Il Survey)

School Year YYYY
School Level Secondary School Session Whole Day
Class Level a1l v Class Name
Subject [ 411 v |
Mol [ 411 w |
Remark 11 w

Search Add || 7 Delets Preview & Print ]

[5-5TU55-03]Student > Subject Survey > Prepare Survey on Senior Secondary Subject Information (Part Il Survey) Data

Prepare Sy eyion Semere condacy subgectin bormnaton iR B RS usv el B Ealm T s e

Survey on Senior Secondary Subject Information (Part Il Survey) - Batch Delete
School Year YT

School Level Seconda ry School Session Whole Day
Class Level A1 v Class Name
Subject 11 |

Mol 411 ~]

Al W
Search <]Ba|:h
Class ﬁ': Student Name Subject Mol Remark
48 11 TUDENT WORG 210 Geography Chinese (Cantonese)

4
21 a0 32 RTUDENT AEC P10 Geography Chinese (Cantonsse) A
40 23 [TUNENT AAF 10 Geography Chinese (Cantonese) 4
] 41 b5  BETUDENT &H (235 Hiztory Chinese {Cantonese) A
] o 2 tudent I B35 Tisu Arts(HEDRE) Chinese {(Cantonese) [ffered by own school or
through Network Frogramme
] 54, 4 tudent E P28 Visu Artz(HEDREE) Chinese (Cantonese) Nffered by own school or
through Netwark Programme
O 5 13 tudent F P35 Tisu Arts(HEDSE) Chinese (Cantonese) Nffersd by own school or
through Metwork Frogramme
(3)
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C. Preview and Print Survey Data

[Path: Student > Subject Survey > Prepare Survey on Senior Secondary Subject Information (Part II Survey) Data >
Preview & Print]

o Please preview the data before generating the outgoing data file. You can preview the
“Number of students by subject according to the Survey on Senior Secondary Subject
Information (Part II Survey)” report by clicking the <Preview & Print> button.

[5-5TUS5-01]5tudent > Subject Survey > Prepare Survey on Senior Secondary Subject Information (Part Il Survey) Data
Emsniz sl sl e T e e e e s e s e e e e e s e s Outgoing Data File

Survey on Senior Secondary Subject Information {Part Il Survey)
School Year YYYY

School Level Secondary School Session  Whole Dayw
Class Level all v Class Name
Subject | 411 v |

Mol [ 411 |

Remark [ 411 |

@ Search ] [_ﬁ Add ][ 7 Delete ]

R-STU081 HHf/Date: DD/MM/YYYY
Page 1 of 1
XXXXXX 5
XXXXXX SCHOOL
EHREHERRE (BEIWEE) TRSREEE KRE)
Number of students by subject according to the Survey on
Senior Secondary Subject Information (Part II Survey)

2

208 HHH/Reference Date : DD/MM/YYYY
FEfy/Year : YYYY/YY

\

4k F]/Class Level: HiJU/Secondary 4

P& /Class Name

BIH/Subject 4A 4B 4C 488/ Total
== 15 0 8 23
Chemistry

thERE 30 31 31 92
Chinese Language

¥ (g5h) 5 12 12 29
BAFS (Acc)

HLERE 30 31 31 92
English Language

EY) 13 12 3 28
Biology

BEE (MEEST) 30 31 31 92

Math (Compulsory)

B (Bl - Boo—) 12 5 0 17
Math (Ext-M1)

NERETgEEE 30 31 31 92
C & Soc Dev
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D. Prepare/Un-prepare Survey Data
[Path: Student > Subject Survey > Outgoing Data File > Prepare]

e Please click the <Prepare> button to prepare the survey data file in the interface of
“Outgoing Data File”.

e Once the data file is prepared, survey data cannot be searched or amended. If you want
to amend the data prepared already, please click the <Un-prepare> button.

[§-5TU56-01]5tudent > Subject Survey > Outgoing Data File
Prepare Survey on Senior 5econdary Subject Information (Part IT Survey]) Data | Liginoineg L Fle

Survey on Senior Secondary Subject Information (Part Il Survey)
File Status Data File Description Preview Type

Survey on enior Zecondary Subject Information (Part IT Burvey) _

Prepare

Un-prepare Confirm Preview

E. Preview Data File
[Path: Student > Subject Survey > Outgoing Data File > Preview]

e You can preview the prepared data in three different formats: Raw, Tabular and Report.

[5-5TU5G-01]5tudent > Subject Survey > Qutgoing Data File

File prepared successiully.
Prepare Survey on Senior Secondary Subject Information (Part IT Surwey) Data | i e fll=

Survey on Senior Secondary Subject Information {(Part Il Survey)
File Status Data File Description Preview Type

Survey on senior secondary Subject Information (Part IT Survew) eu:urt [Report w|

Ra'.'.'
Prepare I Tabular I

:Fﬂ"l.ll 11t

F. Confirm Data File
[Path: Student > Subject Survey > Outgoing Data File > Confirm]

e Please click the <Confirm> button to confirm the data file prepared for submission in the
CDS module.

[§-5TU56-01]5tudent > Subject Survey > Outgoing Data File
Prepare Survey on Senior Secondary Subject Information (Part IT Survey) Data | i ik Fll=

Survey on Senior Secondary Subject Information (Part Il Survey)

File Status Data File Description Preview Type

Survey on Senior Secondary Subject Information (Part IT Survew)

Prepare Un-prepare ' Confirm Preview

| E—
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3. Submission of Data File
[Path: CDS > Outgoing Message > Maintain Message]

Prerequisite: The school key must be valid.

e Please click the message “STU Survey on Senior Secondary Subject Information (Part II
Survey)” in the CDS module. The “View Outgoing Message” window will pop up.

¢ In the pop-up window, please click the <Enerypt> button.

[S-CDS01-01] CDS > Qutgoing Message > Maintain Message

Process Message Upload Data
M Page 1 ~ of21 M ~Bottom

Creatio Ack Time ub School
eI Time ~ Ck Time Code {Reference

= Ready BT Burvey on  [DDMMYYYY ata orma ] waadmin
Eenior 04:47 PM thect (DAT)

econdary LLTvey
ubject [EECE)
Information N
(Part 11 0 lick the messag
| 4 urvey )
e — — — —
0 (2 View Outgoing Message - Windows Internet Explorer ‘
N iew Outgoing Message
O Description
BTU Burvey on Senior Secondary Subject Information {Part I1
— Burwey )
0 || subject (code) 55 Subject Survey [SSCH)
Type (Code) Data (DAT)
] | Message Status Ready
Owner syzadmnin
Creation Time DD/MM/YYYY 04:47 PM
0 Acknowledge Receipt
0 [l Pary EDB
Priority Mormal
School Reference
= ||
O File Attachment
| STHR30FL.DAT Tabular | [ Report

===
@k L]

I Encrypt | Reject || 7 Delete || Gl edit || (] close

e Another pop-up window will be shown, you have to enter the school key and click the
<Encrypt> button. The survey data file will be sent to the EDB via CDS.

-_—
2 View Outgoing Message - Windows Internet Explorer — . S|

[5-CD501-05] CDS > Qutgoing Message > Encryption

.Encryption

Please input the school key.
Effective Period: DD/MM/YYYY - DD/MM/YYYY

School Key
0000888

[ Encrypt ] Close]

Remarks: Il
Please allow a few minutes interval between each batch or individual encryption of
messages.

< The Whole Exercise is Completed <
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FAQ

Pre-task

1. What can we do if we have not received the parameter file from the EDB?

A: The parameter file would be sent to school on 10 October 2024. Please check if the CDS
connection works by sending WebSAMS version or call the CDS helpdesk on 3464 0550 for
support, if necessary.

2.  What can we do if the CDS message cannot be decrypted automatically?
A: The Common Key may be corrupted. Please contact the CDS helpdesk for support.

3. What can we do if we cannot find “Process Incoming Data” in the “Data Communication” and
“Subject Survey” of the Student module?

A: Check if the location access right is granted for the case when working outside the
WebSAMS LAN.
[Path: Security > Access Control > Location Access Control]

Prepare Survey Data

4. If the school has not set up the subject for the students in the School Management module, what
can [ do?

A: The school can add the subject(s) to the students using the “Add” subject function in the
“Subject Survey” sub-module. The record added will be only for the Survey.

5. I cannot find the subject in the drop-down menu for adding the subject to the student.

A: Check whether the status of the subject code is active in the Code Management module.
Change the status of the subject code from “I”” to “A”.
[Path: Code Management > Maintenance > Subject]

6. Why does a student not have a subject which should have been assigned to him/her?

A: (1) Check whether the code of the subject is a school-defined one. If yes, it will not be
captured for the Survey. Please note that the “Subject Mapping” in the School
Management module is not applicable to the Survey.

(2) If the code of the subject is EDB-defined, check whether the subject has been assigned
to the student. [Path: Student > Subject Setup]

7.  What subject code for Mathematics should I choose if a student is taking both the Compulsory
Part and the Extended Part?

A: (1) If a student is taking the M1 in addition to the Compulsory Part, please choose
“code 22S” (Compulsory Part) and “code 23S” (Extended Part — Module 1).

(2) If a student is allowed to study the Extended Part without specifying M1 or M2, with
the intention that they will specify it later, please choose “code 22S” (Compulsory
Part), “code 23S” (Extended Part — Module 1) and “code 24S” (Extended Part —
Module 2).
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8. What can I do if I find this error message when preparing the data file?

[$-5TUS6-D1]Student = Subject Survey > Qutgoing Data File
E-40903 : The STRM of the following student has to be entered: (3A, 15, Student ABC)
Prepare Survey on Senior Secondary Subject Information (Part IT Surwey) Data | 4igingoing Ui File
Survey on Senior Secondary Subject Information (Part Il Survey)
File Status Data File Description Preview Type

Survey on wenior Becondary 3ubject Information (Part IT Survey)

Prepare Preview

A: The message informs you that there is a student without STRN. If school has already sent
Form C for the student, please contact the School Places Allocation Section of the EDB on
2832 7740 for the STRN of the student.

9. What do I need to do when I see the following warning message after I have prepared the data
file?

[5-5TUS6-01]Student = Subject Survey = Qutgoing Data File

File prepared successiully.
Warning: Mumber of students without taking Chinese Language
S50, 1
Warning: Mumber of students without taking Citizenship and Social Development
24D, 2
Warning: Mumber of students without taking English Language
S5C, 1
Warning: Mumber of students without taking Mathematics (Compulsory Part)
240, 1
S5E, 1
YWarning: Number of students without any elective subject.
S50, 5
Prepare Survey on S5enior Secondary Subject Information (Part IT Survey) Data | wiinglng i) Filz

Survey on Senior Secondary Subject Information (Part Il Survey)

File Status Data File Description Preview Type
Survey on Senior Secondary Subject Information (Part IT Burvey)

Prepare Un-prepare Confirm Preview

A: Check whether there are students in the mentioned classes who do not have taken all SS core
subjects (Chinese Language, English Language, Mathematics (Compulsory Part) and
Citizenship and Social Development) and at least one of the SS elective subjects. Please
note that the warning message is not applicable to special schools.

10. Is it necessary to “add” Other Language courses to the students for the Survey if school has not
assigned the Other Language courses to the students in the School Management or the Student

modules?

A: Yes, it is necessary.

11. Do I need to input information on subject(s) offered through Network Programme(s) or by ATEC?

A: Yes, it is necessary.

12. Do I need to input the information of students (especially the Non-Chinese Speaking students)
who are studying Chinese Language not leading to the HKDSE Examination?

A: Yes, it is necessary. Please select “Offered for students not taking HKDSE Examination”
under the remark code for Chinese Language (subject code 080).
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13. Is it necessary to “add” Applied Learning courses to the students for the Survey if school has not
assigned the Applied Learning courses to the students in the School Management or the Student
modules?

A: No, it is unnecessary.

14. Do I need to input the information of subjects taken by S6 students?

A: No. EDB will collect relevant information from the Hong Kong Examinations and
Assessment Authority.

Submission of Data File

15. What can we do if the message cannot be encrypted?

A: Check if the school key has expired. Renew the school key, if necessary.
[Path: CDS > School Key Management > Change School Key]

Miscellaneous

16. Is it necessary for WebSAMS to migrate to the 2024/25 school year before extracting data?
A: It causes no problem whether it is migrated to the 2024/25 school year or not.

17. Is it necessary to update the student attendance data as at 10 October 2024 (Reference Date), i.e.
mark the absentees in the Attendance module on that date, before conducting the Survey?

A: No, itis unnecessary. The attendance records do not affect the survey data.

Enquiries

For general enquiries on the Survey, please contact Ms Elaine CHAN (Tel: 3540 6828) or
Mr Kelvin LEUNG (Tel: 2892 5963) of the Council and Secondary Section 1 of the Curriculum
Development Institute. For matters regarding the use of WebSAMS functions, please call the
School Liaison Officers of the Systems and Information Management Section. For matters
regarding the use of CDS, please contact CDS helpdesk on 3464 0550.

Systems & Information Management Section
Education Bureau
October 2024
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Subject Codes of Senior Secondary (SS) Subjects

Annex

(for Part II of the Survey: WebSAMS Survey on SS Subjects Taken by Students)

SS Subject Subject Code
Business, Accounting and Financial Studies (Accounting) 12N
Business, Accounting and Financial Studies (Business Management) 13N
Biology 045
Chemistry 070
Chinese History 075
Chinese Language 080
Chinese Literature 090
Citizenship and Social Development 092
Design and Applied Technology 31N
Economics 135
English Language 165
Ethics and Religious Studies MNot¢ 1] 41N
Geography 210
Health Management and Social Care 7IN
History 235
Information and Communication Technology 8IN
Literature in English 170
Mathematics (Compulsory Part) 228
Mathematics (Extended Part — Module 1) 23S
Mathematics (Extended Part — Module 2) 248
Music Nete 1] 218
Physical Education ot ] 418
Physics 315
Technology and Living (Food Science and Technology) 728
Technology and Living (Fashion, Clothing and Textiles) 73S
Technology and Living 243
Tourism and Hospitality Studies 718
Visual Arts [Nete 1] 83S
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SS Subject Subject Code
French 200
German 215
Japanese 216
Korean 258
Spanish 398
Urdu 425
Notes

1 ¢ This refers to the SS elective subject, and the code is applicable only to the subject leading to the Hong Kong

Diploma of Secondary Education Examination. Regarding the SS subject for students with intellectual disability
(ID), please use the following code:

SS Subject (ID) Subject Code
Ethics and Religious Studies 185
Music 300
Physical Education 310
Visual Arts 432

Guidelines for “Survey on Senior Secondary Subject Information 2024/25” (Part Il Survey) p.- 17117



